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Naming and Definition

GV-System GeoVision analog and digital video recording software. In most of
documents, the GV-System also refers to Multicam System, GV-
NVR System and GV-Hybrid DVR System at the same time.

GV-Smart Box The GV-Smart Box is a standalone device featuring People

Counting, Face Counting and Gender and Age Recognition
functions. Through the web browser, the GV-Smart Box delivers live
view, face snapshots and gender/age analysis.




Chapter 1 Introduction

n Introduction

The GV-Web Report is designed to integrate and analyze the people counting and face

counting data from GV-Systems and GV-Smart Boxes, as well as gender and age

recognition results from GV-Smart Boxes. Suitable for large-scale video surveillance

deployments, it can receive the data from up to 1000 units of GV-Systems and GV-Smart

Boxes.

Through the Web interface of GV-Web Report, you can access the reports and graphs of

real-time, hourly, daily, monthly and yearly statistics on people traffic and gender and age

distribution. You can also view the live video and the recordings from multiple locations.

GV-System (dbSync 2)

GV-Smart Box
— Up to 1000 units ——
=)= | e =109
Send people/ face counting data, Send people/ face counting data, age/

live video and recardings gender analysis and live video

GV-Web Report Serve’

Access counting data,
live video and recorded files

\ Up to 1000 units

User
(IE browser)

Figure 1-1

Features

e  Support for up to 1000 units of GV-Systems and GV-Smart Boxes

e People traffic monitoring

¢ Real-time, daily, monthly, yearly counting reports and graphs

User
(IE browser)

e E-mail notification and 1/O trigger when the number of people remaining exceeds the

specified maximum

¢ Counting results query from iPhone, iPad and other Android-based mobile devices
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¢ Analysis of gender and age distribution
e Grouping function to combine desired devices’ cameras for data analysis
¢ Remote playback of recordings from GV-Systems

e Face counting results and snapshots from GV-Systems and GV-Smart Boxes

1.1 Minimum System Requirements

The following are minimum system requirements for the server to run GV-Web Report, and
for the GV-System to run dbSync 2 in order to connect to GV-Web Report.

GV-System
GV-System | V8.3.2 or later
Software .Net Framework 3.5
dbSync2

Note: .Net Framework and dbSync2 can be found in the accompanying
software CD.

GV-Web Report

(OS] Windows XP, Vista, Windows 7, Server 2003, Server 2008
Software .Net Framework 3.5

Browser Internet Explorer 7.0 or later

Hardware External or Internal GV-USB Dongle

Note:

1. .Net Framework can be found in the accompanying software CD.

2. GV-USB Dongle for 200, 500 and 1000 clients are available upon
purchase. Note that if multiple GV-USB Dongles are inserted, the dongle
that supports greater number of clients will be used.
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Chapter 2 Installation

2.1 Installing the GV-Web Report

The GV-Web Report program may be installed on a separate computer or the same
computer with the GV-System, but it is recommended to install on a dedicated computer.

Before installing the GV-Web Report, you need to install the USB dongle driver and .Net
Framework first. Follow the steps below to install the programs.

1. Insert Software CD to the computer. This window pops up automatically.

4 v2.1.1.0 GV-Web Report Install program

“\..
. == o -
GeoUision: ?
Install Geo¥ision ¥2.1.1.0 1. Install or R GeoYision GY-Series Dri __!-3 ﬁ ;|
nstall GeoVision ¥2.1.1. . Install or Remove GeoVision GV-5eries Driver - i
GV-Web Report System to your
PC. 2. Install Directx 9.0c
-
3. Install Microsoft .NET Framework 3.5
4. Install GeoYision ¥2.1.1.0 G¥-Web Report System
5. Browse User's Manual [PDF Format]
6. Download Adobe Acrobat Reader

Figure 2-1

2. Toinstall USB driver, select Install or Remove GeoVision GV-Series Driver and click
Install GeoVision USB Devices Driver to start.

3. Toinstall .Net Framework, select Install Microsoft. NET Framework 3.5 to start.

4. Toinstall GV-Web Report, select Install GeoVision V2.1.1.0 GV-Web Report System
and click GeoVision GV-Web Report System to start.
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2.2 Installing dbSync2 on the GV-System

To send people counting data from GV-System to GV-Web Report, it is required to install the
dbSync2 program on the GV-System. Follow the steps below to install the program.

1. Insert Software CD to the computer. The Install Program window (Figure 2-1) pops up

automatically.

2. Toinstall .Net Framework, select Install Microsoft. NET Framework 3.5 (Not
compatible with Windows 2000) to start.

3. Toinstall dySync2, select Install GeoVision V2.1.1.0 GV-Web Report System and
click dySyncz2 to start.
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Chapter 3 Getting Started

The GV-Web Report server is a dedicated computer on a network that analyzes the people
and face counts from GV-Systems and GV-Smart Boxes, as well as gender and age
recognition results from GV-Smart Boxes. The GV-Web Report server enables you to
access the analysis data anywhere through a web browser.

3.1 Starting the GV-Web Report

To start the GV-Web Report service, follow these steps:

1. Run GV-Web Report (from Windows Start menu or from the desktop). For the first-time
user, you will be prompted to enter a password. The default ID (account) is admin.

2. On the GV-Web Report window, click Service from the menu bar and select Data
Service to start receiving data from connected GV-Systems and GV-Smart Boxes.

3.2 Connecting GV-System to GV-Web Report

To send people counting results from a GV-System to the GV-Web Report server, you need
to run the dbSync2 program on the computer of GV-System. To send face counting results
from GV-Systems to the GV-Web Report, use the Face Count function of the GV-System.

Note: To send face counting results from GV-Systems to GV-Web Report, an AVP dongle is

required and the GV-System must be of version 8.4.0.0 or later.
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3.2.1 Sending People Counting Results
1. Run dbSync2 (from Windows Start menu or from the desktop). This dialog box appears.

dbSync? [z|
Synchranization time:
Daily Sync. Time

Time 12:00:00 v

Update Interval

Tirme Minute(s)

Run at Startup

e [ R R N

Figure 3-1

2. Click the Setting button. This dialog box appears.

Sync Canfiguration

Database Path: | CAGY-800\Database |

Gy-Weh Report Configuration

IP Address : [192.168.2.59] | [ Test |

Fort: 30000 |

User Mame : |admin |

Password : |"“‘“‘* |

DR Configuration{For remote access)

IPAddress:  [192.168.0.151 |

Command Port: | 4550
Data Port: 5550

Audio Port: 6550

WViewlog Part h5852

User Mame : 1 |

- |

Password :

Figure 3-2
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3. In the GV-Web Report Configuration section, enter the IP address, username and
password of the GV-Web Report server. Keep the port 30000 or modify it if necessary.
The port value must match the port of GV-Web Report server (Figure 3-10). For details
on account settings on the GV-Web Report server, see 3.6.2 Account Settings.

4. Click Test to connect to the GV-Web Report server. If the connection is established, a
successful connection message will appear on both the GV-System and the GV-Web
Report.

Note: Ensure that the GV-Web Report service has been started (see 3.1 Starting the GV-
Web Report). Otherwise, the connection attempt will fail.

5. Since the dbSync2 program only sends the logged counts to the GV-Web Report server,
it is required to configure the Update the log every x Min. option in the
Counter/Intrusion Alarm Setting on the GV-System. Based on the specified interval in
minute, the counts are logged to the GV-System and will be sent to the GV-Web Report
server through the dbSync2 program.

Camera Applied as Counter E|
Choose Camera [ max. 16
Configure...
W 1 I 5[ 9 [ 13
Clear Al
[~ 2 [ 8 10 [ 14
3 70 11 [ 15
Ok
[ 4 [ 8 12 [ 18
Cancel
[v Update the Log every: & |1 iy,
O At each Clack Haur
W Shavy Object D O m
Figure 3-3

To define a specific time to send people counts to the GV-Web Report server, see 3.3
Configuring the dbSync2 Program on GV-System.
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3.2.2 Sending Face Counting Results

To send face counting results from GV-Systems to GV-Web Report, an AVP dongle is
required and the GV-System must be of version 8.4.0.0 or later. Make sure remote access to
GV-Systems has been enabled on GV-Web Report. See 3.6.3 Remote Access settings for
details.

1. On the GV-System, click the Configure button, select Advanced Video Analysis and
select Face Count Setting.

2. Select the cameras you would like to configure and click Configure. This dialog box
appears.

Face Count

¥ Carmera
Camera Selection

Camera 1 hd

Definition

@ Mask Region
" Detected Face Size
et

Setting
Alarm Type

Option

ace Coun
Resetat |12 o'clock
-

Sensitivity 3
[ Sawe counting results 1o G\V-Weh Report J
. |
— r
Schedule Test @ = @
oK Cancel ‘
Figure 3-4

3. Select Face Count under Alarm Type.

4. In the Option section, select Save counting results to GV-Web Report. A dialog box

appears.
Web Report @

Domain Mame or IF |

Ardrrss

Port |

Useriame |

Password I

Test Cancel
Figure 3-5

5. Type the Domain Name or IP Address, Port, UserName, and Password of the GV-
Web Report. The default port number is 30000. For details on account settings on the
GV-Web Report server, see 3.6.2 Account Settings.

6. Click OK.
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3.3 Configuring the dbSync2 Program on GV-System

The dbSync2 program, installed on the computer of GV-System, sends people counts to the
GV-Web Report server. It also enables remote access to the GV-System for live video and
playback applications.

1. Run dbSync2. This dialog box appears.

dbSync2

Synchronization time:

Daily Syne. Time
Tme 120000 %

Update Interval
Tirne 5 Minutes)

Run at Startup

o | N N

Figure 3-6

m  Daily Sync. Time: Specify a time to send the counts to the GV-Web Report server
automatically.

m  Update Interval: Specify a time interval in minute to send the counts to the GV-Web
Report server automatically.

m  Sync: Click this button to send the counts to the GV-Web Report server immediately.

m  Batch: Click this button, and select the desired data files to be sent to the GV-Web
Report server. The files of people counts are named with prefix "sys", e.g.
sys20071127. The default path for data files is: \GV folder\database.

m  Setting: Click this button to configure connections to the GV-Web Report server.



Q GeoUision:

2. Click the Setting button. This dialog box appears.

&k Setting @l
Syne Configuration
Databage Path:  |CAGV-800MDatabase
GY-eh Report Configuration
IP Address:  [192.168.2.56]
Port 30000
UserMName: |admin
Pasgward: |7
DVR Configuration(Far rermote access)
IP Address 192.168.0.151
Command Port: 4550
Data Port 5550
Audio Port: BA50
Viewlog Port 5552
User Narne : 1
Pasgword :
Update
Figure 3-7

[Sync Configuration] Displays the database path. The default path for database is: \GV

folder\database.

[GV-Web Report Configuration] Type the connection information of the GV-Web
Report server, including its IP address, login username and password. The default port
value is 30000. Click Test to ensure the connection information is correct.

[DVR Configuration for Remote Access] The configuration allows remote access to
the live video and the recordings of GV-System. Before the configuration, enable
WebCam Server on the GV-System first so that the dbSync2 program can automatically
acquire the necessary port values (Common Port, Data Port, Audio Port and Viewing
Port) from the GV-System. Enter the IP address, login username and password of the
GV-System. Then click Update to send the configuration values to the GV-Web Report

server.

3. Click OK. The dbSync2 program is minimized to the notification area.

*, . o 631 PM
¥

When people counts are logged to the GV-System, the dbSync2 program will send it to the
GV-Web Report server at the specified time or time interval each day. You can not only
query counting data, but also view live video and recordings through an IE browser

anywhere.

10
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3.4 Connecting GV-Smart Box to GV-Web Report

To send either people counts or face counts and gender and age recognition results from a
GV-Smart Box to the GV-Web Report server, you need to configure the GV-Smart Box to
allow connection to GV-Web Report. For details, see 7.7 Connecting to GV-Web Report in
GV-Smart Box User’s Manual.

1. Select Events and Alerts and then Web Report Setting in the Web interface of the GV-
Smart Box. This page appears.

Webh Report
In this section you can configure the connection to Web Report.

Weh Report

[ Enanle

Hostname or P Address |[192.168.0.123
Port Mumber 30000

User Mame 1

Pazsword .

Connection Status

Status: Connected. Connected Time:Wed Mow 3 11:47:22 2010

Figure 3-8
2. Enable the Web Report function.

3. Enter the IP address of the GV-Web Report server, and the login username and
password. Then click Apply.

The Connection Status is shown on the bottom of the page to show whether GV-Web
Report is connected and the time of connection.

11
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3.5 The Main Screen of GV-Web Report

& GeoVision GV-Web Rezport

Service Browse Tools Help
07—: B eSSt R Events
e = &8 Online(2) [ Time Account  Device IP Address Action Result
E GY-Smart Box || 2010-06-1513:31:45 1 GV-Smart Box-PP 192.168.0106 Device Login. Success
ﬁ GV-Srmart Bon 2010-06-1513:31:38 admin  GV-Smart Box 192168.258  Device Login.  Success
€ Offine(0)
< |1
Figure 3-9
No | Name Description
1 Host List Displays connected hosts.
2 Event List Displays the connection information.
3 | Service Enables and disables the GV-Web Report services.

m Data Service: Allows connection to GV-Systems and GV-
Smart Boxes.

B Web Service: Accesses to the GV-Web Report’s Web
Interface. Also allows remote access to live video and
recordings of GV-System as well as face snapshots captured
from GV-Smart Boxes.

4 Browse Links to the Web interface of the GV-Web Report.
5 | Tools Accesses the advanced settings. See 3.5 Configuring the GV-Web
Report.

12
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3.6 Configuring the GV-Web Report

To access more settings of the GV-Web Report server, click Tools (No. 5, Figure 3-9) on
the main screen. The following sections describe these advanced settings: General Settings,
Account Settings, Remote Access Settings, Database Settings, E-Mail Settings, and UPnP
Port Mapping Settings.

3.6.1 General Settings

The General Settings allow you to configure the communication ports of the GV-Web Report

server and automatic startup services.

£F General Setup @

Data Server
Server Name TEST141

Listen Port 30000

bz Client Limit (100 (Max value is 200)
[ Auto Start Senice

WWab Server

Listen Port |80

[ Auto Start Serica

[ Auto startup after login Yindows
[] startup Auto Login

Resetto default

Apply

Figure 3-10
[Data Server]
m  Server Name: Name the GV-Web Report server. The default value is the computer
name.
m Listen Port: The default port value of the GV-Web Report server is 30000. The port

value must match the GV-Web Report related port on a GV-System (Figure 3-2) and GV-
Smart Box (Figure 3-8).

m  Max Client Limit: Define the maximum number of GV-Systems and GV-Smart Boxes
that can be connected to the GV-Web Report. The maximum value is indicated on the
right.

m Auto Start Service: Automatically start connection to GV-Systems and GV-Smart Boxes
once the GV-Web Report server is started.

[Web Server]

m Listen Port: The default port value is 80. The HTTP port enables connecting the GV-
Web Report server to the Web.

13
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m  Auto Start Service: Automatically start the remote access to GV-Systems and GV-
Smart Boxes.

m  Auto startup after login Windows: Automatically start the GV-Web Report server after
Windows startup.

m Start Auto login: Automatically log into the GV-Web Report server after Windows
startup. Click the Arrow button to enter the login account and password.

3.6.2 Account Settings

Using the Account Settings, the GV-Web Report supervisor can create new accounts with
different access rights. The supervisor account has the privilege to log into the GV-Web
Report and make configuration settings, while the user account is only allowed to access the
Web interface of the GV-Web Report. The maximum account number, including supervisor
and user accounts, is 100.

Account Uszer Setting
Users(d Account
= Supervizors(1)

admin

MNew Password

Confirm Mew Password

Apply

General Setup | G\eh Report
Allow Yeh Login

Allow Remate Playback
Allow Live Wiew

Figure 3-11

For details on the Allow Group Setting option in the GV-Web Report tab, see 4.3 Group
Page.

14
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3.6.3 Remote Access Settings

The Remote Access Settings display the available GV-Systems and GV-Smart Boxes for
remote access to their live video, recordings, and face snapshots through the web browser.
The asterisk * on the State column indicates that the account name and password are
required for access to the specific device. To allow remote access to the GV-System or GV-
Smart Box, select the device on the list and then enter its login account name and password.

&5 Remote Access Setting @

Device

State Device Type Device IF Address Account
* GEOVISIO-TYFECD 192.168.2.129
* AlexLocalDVR 192.168.0.227
* DWR 192.168.2.160
* TEST144-DF33DC2  192.168.0.226
* TEST16 192.168.0.186

< | =

Remote Access Setting
GComrmand Part: 4550

video Port 5550

ViewLog Port: 5552

|
|
Audio Part: 8550 |
|
|

Accaunt |1

FPassword |* |

l Resetto default ” Apply l

Figure 3-12

15
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3.6.4 Database Settings

You can modify the storage path of the GV-Web Report’s database, specify the number of
days to keep the database, and change the storage path of face snapshots from GV-Smart
Boxes.

If the computer of the GV-Web Report server is of NTFS file system, you can select Enable
Database Compression to save disk space.

Database @

Setting

Fath I'\Program FilesiGeat D
Keep Days {0; unlimited)

Snapshot Folder. | [\Program FilesiGeot D

Figure 3-13

3.6.5 E-Mail Settings

Using the E-Mail Settings, you can send e-mails to the supervisor when a GV-System or
GV-Smart Box is disconnected. You can also send e-mail notifications when the number of
people remaining reached the pre-defined maximum. See 4.3 Group Page on how to set the

maximum.

E-Mail Setting

E-Mail Setting

SMTP Sener: | |
Fram | |
TO | |
Subject | |
SMTF Authentication Setting SMTF Senver Setting
[] SMTP Mail Server requires authentication SMTP Part
Account | | [JssL

Passward | |

Figure 3-14

16
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3.6.5.1 Setting Mail Server

1.  Enter URL or IP address of the SMTP server.

2. Enter the sender’s e-mail address. The entered e-mail will appear as sender when the

e-mail is received.

3. Enter the recipient’s e-mail address. For multiple recipients, add a semicolon between
each e-mail address.

4. Enter a subject coming with the alert message.

5. Click Test E-Mail Account to send out a test e-mail to see whether the setup is correct.
If the connection attempt fails, you may also need to check the settings of SMTP
Authentication Setting and SMTP Server Settings described below.

Other options on the dialog box:

[SMTP Authentication Setting] If your e-mail service provider requires authentication for
sending e-mails, select this option and enter the account ID and password of your SMTP.

[SMTP Server Setting]
m  SMTP Port: Enter the SMTP port value. The default value is 25.

m  SSL: If your e-mail server requires an SSL (Secure Sockets Layer) authentication for
connection, select this option.

3.6.5.2 Setting E-Mail Alert

When a GV-System or GV-Smart Box is disconnected from the GV-Web Report, the e-mail
will be sent out to warn the supervisor. Follow the steps below to set the e-mail alert.

1. Right-click the host in the host list and select Host Setting.

(ﬂ GeoVision GV-Web Report

Service Browse  Tools  Help

= £ TEsTIST " [ Brems
€& online( Time Account
=B Offline(2)
E GW-Srnart Box

GY-Smart Box-PF

Host Setting

Figure 3-15

17
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2. Enable Send E-Mail Notification when disconnected, and click OK.

Natification |

Send E-Mail Motification when disconnected.
E-tiail Setting

Figure 3-16

18
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3.6.6 UPnP Port Mapping Settings

The GV-Web Report server supports UPnP technology (Universal Plug and Play) to allow
automatic port configuration to your router.

In order for UPnP to be enabled, the following requirements must be met:

e Windows XP Service Pack 2 or later

e Windows operating system has been configured to use UPnP (see Enabling UPnP in
Windows XP, Appendix)

e UPnP has been enabled on your router (consult your router’'s documentation)

To enable UPnP on the GV-Web Report:

1. Click Tools from the menu bar and select UPnP Port Mapping Setting. This dialog box
appears.

Port Mapping

UPnP-based Router

i

Name Port IP Address NOTE |
) G\-Web Report Port 30000 162168.2.168
0 weh Server Port 8080 192.160.2.168

25 | &

20:41:01- Mo UPnP devices available
20:40:58- Searching far UPNP enabled routers

Figure 3-17
2. Click Searching to search the UPnP-enabled routers.

3. If your server is installed with more than one router, select a desired one from the UPnP-
based Router drop-down list.

4. If you server is installed with more than one network adapter, select a desired one from
the drop-down list.

5. Click Configure to automatically configure the communication ports on the router.

Tip: If you don’t use the default ports, modify the related ports in the General Settings dialog
box (Figure 3-11), re-open the UPnP Port Mapping dialog box and follow above steps to
configure your router.

19
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Chapter 4 Accessing People Counting

Page

After the GV-Web Report Service is started, you can access the counts, graphics and live
video on the network. The GV-Web Report is divided into 2 pages, People Counting page
and Face Counting page. This chapter describes in details the functions of the People

Counting page.

¢ People Counting page: provides counting data regarding the number of people in, out of,
and remaining in the surveillance area. The counting data can be from GV-Systems and
GV-Smart Boxes.

¢ Face Counting page: provides face counting data, and gender and age recognition
results of people entered the surveillance area. The counting data can be from GV-
Systems and GV-Smart Boxes.

Note: For remote viewing through network, Internet Explorer 7.0 or later is required.

4.1 Accessing People Counts and Graphics

To access people count results through the web browser, ensure that Web Service on the
GV-Web Report server has been enabled as shown below; otherwise the login through the

web browser will fail.

& GeoVision GV-Web Report

Service | Browse Tools  Help

Start all zervices

Stop all senvices

Data Service
YWeh Service

[<J[<]

Logout
Exit

Figure 4-1

20



n Accessing People Counting Page

1. Two methods to access the Web interface of GV-Web Report:

A. If you are at the local GV-Web Report server, select Browse on the main screen of
the GV-Web Report (Figure 3-9) and select GV-Web Report Data. The login page

appears.
@\, J~ Bl 127.0.0.1 v
Fle Edt Vew Favortes Tooks Help
o Favorites | o5 @& * £ Free Hotmail &
_@Lugm

('.' GeoUision

Sign In with your account

Enter the
characters shown #4168

in the image

emember my Account and
Password

©2009 GEOVISION INC.ALL RIGHTS RESERVED.

Figure 4-2

B. If you are at a remote computer, start the Internet Explorer browser. Enter the IP
address or the domain name of GV-Web Report in the Location/Address field of your
browser. The login page appears.

2. Enter the login ID and Password of the GV-Web Report. The ID and Password should
match those of any account set in the Account dialog box (Figure 3-11).

3. Enter the characters shown in the image.

4. Click Login. The Web page similar to the following example is now displayed in your

{2 hitp:#192.168.0.151/NVR_Counter. php?SYSTEM=P - Windows Internet Explorer EEXE
—

@ v | hitp:Ji132.168.0.151 /MR _Courter. php?SYSTEM=P <[4 [x] | |2l

Fle Edt ‘Wew Faworites Took Help Links ™
W R [ﬁhttD:ﬂfl?Z‘IEB‘DJSUNVR,CauntehDhDEVSTEM:P liw - B @ - [GhPage v £ Tooks -

(2 Geavision GV-Web Report - People Counting

User: 1 Logout

@ :0nLine 8 :OffLine

> GV-Smart Box-pp@ In 0

> Counting Signage out o
Average In o

Average Out o

Total In: 0 | Total Out: 0 | Stay: 0
® Update Frequency : 60 seconds
® Total In(Out): on behalf of today 0:00 until now In(Out) ® Last Updated : 02:37:55
® Average In(Out): on behalf of today 0:00 until now average In(Out) per minute ® 54Seconds later update

Total Device Real-time In and Out chart

Figure 4-3

5. To display the graphs, it is required to download Microsoft Silverlight to your computer.
Click the link on the page to start downloading the program.
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4.2 Device Page

On the Device page, you can access three types of people counts of the current day.

Main page

On the main page of the Device page, the people counts of the
current day are updated from the GV-Web Report server every
minute. See 4.2.1 Viewing the Counts Updated Every Minute.

Counting Signage

On the Counting Signage page, the people counts of the current
day is updated from the GV-Web Report server immediately. See
4.2.2 Viewing the Current Counts.

Live View Window

On the Live View window, the people counts are updated directly
from a GV-System. You can also view live video from a GV-
System or GV-Smart Box. See 4.2.3 Viewing Live Video.

4.2.1 Viewing People Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web

Report server. The page displays the people counts and graphs of all connected GV-

Systems and GV-Smart Boxes.

(2 Geovision GV-Web Report - People Counting

Device | Group | Log | Query

User: admin  Logout

» Total List

> DVR@

> TEST168
» TESTSSE

@ :onLine 8 :Total List

> GEQVISIO-77FECD B
» AlexLocalDVRE

» TEST144-DF98DC28

> Counting Signage

‘GEOVISIO-77FECD exlocalDVR

n |0 In 19,681 In 2,882
out |0 out 19,144 out [2,877
Average Average Average
mn_|° mn_ |°>° mn_|*
Average Ayerage Average
ot |° out  |°8 out |*
TEST144-DF98DC2 TEST16 TESTSS
In  |24,016 In 478,635 In  |134
out  |23,926 out  |a29,528 ot [110
Average Average Average
n |3 o |708 sl
Average Average Average
ou |*3 out  |53% ot |°

Total In: 525,348 | Total Qut: 475,585 | Stay: 49,763
+ Update Frequency : 60
s Total In[Out): on behalf of today 0:00 until now In{Out) seconds

« Average In(Out): on behalf of today 0:00 until now average In(Out) per * Last Updated : 11:16:21
minute + 535econds later update

Total Device Real-time In and Out chart
€0,000

Figure 4-4

The counts on the main page show:

® In: The number of people entered during the day.

Out: The number of people left during the day.

[ ]
m Average In: The average number of people entered every minute during the day.
[ ]

Average Out: The average number of people left every minute during the day.




n Accessing People Counting Page

Total In: The total number of entered people from multiple devices during the day.

Total Out: The total number of left people from multiple devices during the day.

Stay: The number of people remaining. That is subtracting the number of Total Out from
the number of Total In.

On the left menu, you can find these options:

m Total List: Select one device under the list to access its individual counts. A green mark
indicates that the device is now updating data to the GV-Web Report server; otherwise a
red mark appears. On the individual device’s page, the people counts of the current day
are updated every minute from the GV-Web Report server.

© Camera: Access the live video if remote access is enabled on both the device and
GV-Web Report server. See 4.2.3 Viewing Live Video later in this chapter.

m  Counting Signage: Access the people counts of the current day updated immediately
from the GV-Web Report server.

(2 Geobision GV-Web Report - People Counting

Device | Group | Log | Query

@ :onLine 8 :0ffLine —
» Total List GV-Smart Box

> GV-Smart Box@® In
» CAMERA_NAME(Live View) Qut
» GV-Smart Box-PP@ Average In
» Counting Signage Average Out

olo|o|o

Total In: 0 | Total Out: 0 | Stay: 0

o Total In{Out): on behalf of today 0:00 until now In{Out)
o Average In(Out): on behalf of today 0:00 until now average In{Out) per minute

Figure 4-5

4.2.2 Viewing the Current People Counts

To view the people counts of the current day continuously updated from the GV-Web Report

server, select Counting Signage from the left menu of the Device page.
0.0.1:B080/App/Counter_Signage.php? TYPE-ALLD do ernet Explore

] http:/j127.0.0.1:8080/Appj Cotnker_Signage.php?TYPE=ALLDEYICE v

GEOVISIO-77FECDll AlexlocabvR f @ DVR |
In 0 In 19681 In 2882
out 0 Out (19144 out 2877
TEST144-DF98DC2 TEST16 TESTS8
In 24016 In 478635 In 161
out 23926 Out 429528 out |129
Figure 4-6
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4.2.3 Viewing Live Video
To access live video, select the desired camera from the left menu of the Device page. To
have video streaming, ensure the following settings have been configured or enabled:

e GV-System: WebCam Server and DVR Configuration for Remote Access settings
(Figure 3-7) on dbSync2

e GV-Web Report: Configuration for Remote Access settings (Figure 3-12)

(2 Geoision GV-Web Report - People Counting

Device | Group | Log | Query User: admin  Logout
> Camera 15(Live View) ¥
> Camera 16(Live View) I

» AlexLocalDVRIEB

People Count

> DVR®

» TEST144-DFOSDC28 - -
» TEST168 o ! -

> TEST22@ Y ==

= Start Time
200912423 15:04:10

» Camera 1(Live View)
» Camera 2(Live View)
» Camera 3(Live View) P 1 T ¥ . = In
» Camera 4(Live View) \ 11
» Camera 5(Live View)

= Qut
]

» Camera 6(Live View)
» Camera 7(Live View)
» Camera 8(Live View) LS Ehe. . = Stay People
» Camera S(Live View) b 5

> Camera 10(Live View) - - :

» Camera 11(Live View)
> Camera 12(Live View) > I [ ] JE”

> Camera 13(Live View)

> Camera 14(Live View)

> Camera 15(Live View)

» Camera 16(Live View)
» Counting Signage

Figure 4-7

By clicking the Start button on the Live View window, you can view the updating counts from
the GV-System.

Note:

1. The In and Out counts on the Live View window is updated directly from the GV-
System instead of the GV-Web Report server.

2. Once the counts are logged into the GV-System, the In and Out counts will become
zero and the GV-System will start counting those numbers again.

3. The GV-Smart Box does not support the direct update of the people counts on the Live
View window.
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4.3 Group Page

On the Group page, you can group different cameras from different GV-Systems and GV-
Smart Boxes, and see the people counts of the set group. You can also set up the maximum
number of people entered, left and remaining to activate the computer alarm. 1/O trigger to
warn the onsite operator of the GV-Web Report server and e-mail notification can be

activated when the number of people remaining reaches the pre-defined maximum.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

(® GeoVision b / i
GV-Web Report - People Counting
ice | Group | Log | Query User: 1 Logout
> Total List Add Group
Wemage Eroup GY-Smart Box
> Add Group Camera [] CAMERS,_NAME
> Maintain Group v S
Manage Email Group
> Add Email Group Out Maximum
> Maintain Email Group Stay Maximum l:l
Manage 1/0 Device ;
Set email for reaching the
> Add 1/0 Davice o i Oves ®No
> Maintain 1/0 Device Set IO trigger for reaching the
A i e e OYes @ MNo
» Counting Signage

Figure 4-8
2. Name the group.
3. Select the cameras that you want to include in the group.

4. In the Maximum In field, set the maximum number of people that can enter during the
day before activating the computer alarm.

5. In the Maximum Out field, set the maximum number of people that can leave during the
day before activating the computer alarm.

6. In the Maximum Stay field, set the maximum number of people that can remain during
the day before activating the computer alarm, sending a notification e-mail or triggering
an output device.

7. To receive e-mail naotifications when the maximum number of people remained is
reached, select Yes for Set email for reaching the maximum.

8. To trigger an output device when the maximum number of people remained is reached,
select Yes for Set I/0 trigger for reaching the maximum.

9. Click Submit.

10. From Total List in the left menu, select the set Group to see the sum of every people
count from those selected cameras.
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To set up e-mail notifications:

To receive e-mail notifications when the maximum number of people remaining is reached,
you must first set up the mail server on the GV-Web Report server, and then set up an e-
mail group as below. To set up the mail server to send e-mails, see 3.6.5 E-mail Settings.

1. Select Add Email Group from the left menu of the Group page. This page appears.

C geatis .
GeoUision GV-Web Report - People Counting
ice | Group | Log | Query User: 1 Logout
> Total List Add Email Group
» FAE Email Group
Manage Group
» add Group Group member email
» Maintain Group =
Manage Email Group “More than
s &dd Email Group one Ip&rSDn 5
» Maintain Email Group p ease_
separate with a
Manage 1/0 Device 5
semicolon
» add 1[/O Device
» Maintain 1fO Device
» Counting Signage

Figure 4-9
2. Name the group.

3. Inthe Group member email field, type the E-mail address to sent notification to.
Separate multiple e-mail addresses with semicolons.

4. Click Submit.

5. Customize the e-mail subject and content by clicking Maintain Group and then the

Update Group button E. Type the e-mail subject and content.

6. To edit an existing e-mail group, select Maintain Email Group and click the Update

Group buttonE . To delete an existing group, click the Delete Group button @.
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To set up I/O triggers:

The /O trigger warns the onsite operator of the GV-Web Report server when the number of
people remaining reaches the pre-defined maximum. The /O trigger function only supports
these GV I/O devices: GV-I/O Box 4 Ports, 8 Ports and 16 Ports.

Note: The /O trigger function only supports one output device through a GV-I/0 Box, and
the GV-1/0O Box needs to be connected to the COM port of the GV-Web Report server.

Select Add I/0 Device from the left menu of the Group page. This page appears.

(2 6eovision j
GV-Web Report - People Counting
Device | Group | Log | Query Useri 1 Logout
> Tatal List Add 1/0 Device
» FAE Device Name GWIO-USB(d) v
Manage Group Port O v|
» Add Group
» Maintain Group Address 118
Manage Email Group Qutput Signal Type
Add Email G
’ mafl Group MNFO NfO Toggle MNfO Pulse l:lSec
» Maintain Email Group O Cutputl |:|
Manage 1/0 Device MNFC N/ Toggle NfC Pulse Sec
» Add 170 Device O outputz NfO MN/O Toggle N/D Pulse l:lSE!E
utpu
» Maintain I/0 Device Sutput MfC N/C Toaggle MN/C Pulse l:ISE!E
» Counting Signage
NfO MNfO Toggle /O Pulse l:lSec
[ output=
MNfC MN/C Toggle MN/C Pulse l:ISec
NfO NfO Toggle MNfO Pulse l:lSec
[ output4,
MNfC MN/C Toggle N/C Pulse l:ISec
Figure 4-10

Select the device name from the drop-down list.
Select the corresponding COM port and address for the 1/0O device.

Select the output to trigger and its signal type. For Pulse type, specify the amount of time
in second you want the output device to be triggered for.

Click Submit.

On the left menu of the Group page, you can find these options:

Total List: Access the people counts of the set groups updated every minute from the
GV-Web Report server.

Counting Signage: Access the people counts of the set groups updated immediately
from the GV-Web Report server. When the limit of Maximum In, Maximum Out or
Maximum Stay is reached, the warning texts will be displayed on the page and the
computer alarm will be activated too.
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4.4 Log Page

On the Log page, you can view the people counts of a specified time period from GV-

Systems and GV-Smart Boxes.

GV-Web Report - People Counting

(® GeoUision

Device | Group | Log | Query User: admin  Logout
® Device: The page show record 1-7 , total number of records : 7
total number of pages: 1
) Group:
Start Time: [2009-12-24 [ ][00 v . Query Result List
, Device Name | Camera Start Time End Time In | Out | VIDED CLIP
i ] TESTSg M | Camera 1| 2009-12-24 15:01:13 2009-12-24 15:01:31 |20| 31 E
End Time: |2009-12-24 -
m TESTSs M | Camera 1 | 2009-12-24 15:01:33 2009-12-24 15:02:23 |43 | 44 E
| w
’ TESTaS (M Cameral | 2009-12-24 15:02:24 2009-12-24 15:03:24 |42 22 E
PR (OfekaAl V7 TESTSE (M Cameral | 2009-12-24 15:03:24 2009-12-24 15:04:24 |17 12 H
TESTSS (M Cameral | 2009-12-24 15:04:24 2009-12-24 15:05:24 |40 35 H
TESTaG (M Camera 1l | 2009-12-24 15:05:24 2009-12-24 15:06:24 |3 | 0 E
TESTSE (M Cameral | 2009-12-24 15:06:24 2009-12-24 15:07:24 |30 40 H
Figure 4-11

To search the log data:

1. Select a specific GV-System or a GV-Smart Box from the Device drop-down list or a

created group from the Group drop-down list.
2. Specify Start Time and End Time of the log data.

3. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

4. Click Query to display the search results.

& &

To back up the found log data in EXCEL and WORD format, click the icons
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4.4.1 Playing Back Recordings

To retrieve recordings, click the Video Clip icon on the Log page. The following playback
window will appear. To have video streaming, ensure the following settings have been
configured or enabled:

e dbSync2: DVR Configuration for Remote Access (Figure 3-7).
e GV-System: WebCam Server with the Run Viewlog Server option enabled

e GV-Web Report: Configuration for Remote Access settings (Figure 3-12)

Note: The GV-Smart Box does not support the playback function.

2 Camers 4

G/852003 20: 4537 577 + 2

Figure 4-12

Playback scroll

: — Move to prev 5 min

Move to prev 1 min

-

p|ay7h Il B W4 M M

Pause T Move to next 1 min
Stop Move to next 5 min

Home End
Backward Forward
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Right-click the playback window to have the following features:

Play Mode Includes these options:
®  Frame by Frame: Play back video frame by frame.

® Real Time: Play back video on real time. This mode saves waiting
time for rendering, but drop frames to give the appearance of real-
time playback.

m  Auto Play Next 5 Minutes: Play back video up to 5 minutes.

®m  Audio: Turn on or off the video sound.

Render Includes these options:
m Deinterlace: Convert the interlaced video into non-interlaced video.
m Scaling: Smoothen mosaic squares when enlarging a playback video

m Deblocking: Remove the block-like artifacts from low-quality and
highly compressed video.

m  Defog: Enhance image visibility.
m Stabilizer: Reduce camera shake.

m  Text overlay’s camera name and time: Overlay camera name and
time onto the video.

m  Text overlay’s POS/GV-Wiegand: Overlay POS or GV-Wiegand
Capture data onto the video.

m Full Screen: Switch to the full screen view.

Tools m Snapshot: Save a video image.
m Save as AVI: Save a video as avi format.

®m Download: Download the video clip to the local computer.
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4.5 Query Page
The Query page provides you with the daily, weekly, monthly and yearly people counting

graphs and tables.

To search the counting data, select a GV-System or GV-Smart Box from the Device drop-
down list or a created group from the Group drop-down list, specify a date, and select the

options below. Use the Chart drop-down list [chart : e Grapn ¥ | 16 choose to display the data
using bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data:
e In/Out Counts per hour and Total Stay
e Total In, Out and Stay per Hour
e In Counts per Hour
e Out Counts per Hour
e Total Stay per Hour

[Daily Report] Display the counting report of the specified date.

® [n/Out Counts per hour and Total Stay: The hourly number of people entered and left,
and the total number of people remaining until now.

m Difference between In and Out per hour: The hourly number of people remaining.

m Total In, Out and Stay per hour: The total number of people entered, left and remaining
during the day.
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The following figure is an example of the In/Out Counts per hour and Total Stay option.

The value 16, 179 indicates the count of remaining people until 16 pm is 179.

L] -z .
(2 Geoision GV-Web Report - People Counting
Device | Group | Log | Query User: 1 Logout
2

) Device: Chart ; | Line Graph %
G - [2010-11-01] In/Out Counts per hour and Total Stay(All Device)

y Report(2010-11-1)
InfOut Counts per hour and Total 250
Stay
Difference between In and Out per
hour 200 16, 176

Total In, Out and Stay per hour

T— —

a 1 2 3 4 5 & 7 2 % 10 11 12 123 14 15 16 17 18 1% 20 21 22 22

== |n == Qut =C= Total Stay

Time In out Total Stay
0:00 64 40 24

100 3 3 26

2:00 64 42 45

3:00 16 7 57

4:00 Fi=) 52 a1

5:00 48 31 ag

6:00 16 El 1035

Figure 4-13

[Weekly Report] Display the weekly report that contains the data of 7 days before your
specified date.

® In Counts per hour: The hourly number of people entered for the week.

m  Out Counts per hour: The hourly number of people left for the week.

m  Total Stay per hour: The hourly number of people remaining for the week.

m In Percentage per hour: The hourly percentage of people entered for the week.

m Stay Percentage per hour: The hourly percentage of people remaining for the week.
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The following figure is an example of the In Percentage per hour option. The value 15:00,
65 (9.02%) indicates the total number of entered people at 15 pm every day for the week is
65. The number takes up 9.02 percent of the total people entered for the week.

»» Face Counting

L] q
(2 Geovision GV-Web Report - People Counting
Device | Group | Log | Query User: 1 Logout
©bevice: Chart 1
O Group:

[2010-10-26~2010-11-01] In Percentage per hour(All Device)

Time: [2010-11-1 |=]

15:00, 65(9.02%)

In Counts per hour

Qut Counts per hour

Total Stay per hour

In Percentage per day

In Percentage per hour

Stay Percentage per hour

& 0:.00 1:00 & 2:00 300 @ 4:00 & 5:.00 600 @ 7:00 & 8:00 900 & 10:00 & 11:00 @ 12:00
® 13:00  14:.00 @ 15:00 » 16:00 @ 17:00 & 18:00 @ 1200 @ 20:00  21:00 @ 22:00 & 23:.00

Time In Percentage®
g:00 64 8.88

1:00 5 0.69

2:00 64 .88

3:00 16 2.22

400 76 10,54

5:00 48 6.66

.00 16 2.22

Figure 4-14
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[Monthly Report]
m In Percentage per day: The daily percentage of people entered in the month.
m In Percentage per hour: The hourly percentage of people entered in the month.

m Stay Percentage per hour: The hourly percentage of people remaining in the month.

[Yearly Report]
m In Percentage per month: The monthly percentage of people entered in the year.
m  Out Percentage per hour: The hourly percentage of people entered in the year.

m Stay Percentage per hour: The hourly percentage of people remaining in the year.
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Chapter 5 Accessing Face Counting Page

After the GV-Web Report Service is started, you can access the counts, graphics and live
video on the network. The GV-Web Report is divided into 2 pages, People Counting page
and Face Counting page. This chapter describes in details the functions of the Face
Counting page.

¢ People Counting page: provides counting data regarding the number of people in, out of,
and remaining in the surveillance area. The counting data can be from GV-Systems and
GV-Smart Boxes.

¢ Face Counting page: provides face counting data, and gender and age recognition
results of people entered the surveillance area. The counting data can be from GV-
Systems and GV-Smart Boxes.

Note:
1. The Face Counting function is only supported in GV-System version 8.4.0.0 or later.
2. For remote viewing through network, Internet Explorer 7.0 or later is required.

5.1 Accessing Face Counts and Graphics

To access face counts and gender and age recognition results through the web browser,
ensure that Web Service on the GV-Web Report server has been enabled as shown below;
otherwise the login through the web browser will fail.

Service | Browse Tools  Help

Start all zervices

Stop all services

Data Service

[~]
Weh Senice

Logout
Exit

Figure 5-1
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1. Two methods to access the Web interface of GV-Web Report:
A. If you are at the local GV-Web Report server, select Browse on the main screen of
the GV-Web Report (Figure 3-9) and select GV-Web Report Data. The login page

appears.

_@ L el 127.0.0.1 i

File Edit Wiew Favorites Tools  Help

S Favorites | 515 & ~ &] Fres Hotmal & -
& Login

(2 Geovision

Sign In with your account

Enter the i g
characters shown 3168

in the image :

Remember my Account and
Password

©2009 GEOVISION INC.ALL RIGHTS RESERVED.

Figure 5-2

B. If you are at a remote computer, start the Internet Explorer browser. Enter the IP
address or the domain name of GV-Web Report in the Location/Address field of your

browser. The login page appears.

2. Enter the login ID and Password of the GV-Web Report. The ID and Password should
match those of any account set in the Account dialog box (Figure 3-11).

3. Enter the characters shown in the image.

4. Click Login. The Web page similar to the following example is now displayed in your

browser.

= http:4/192.168.0.151NVR_Counter. php?SYSTEM=P - Windows Internet Explorer

@:{ - |(‘i hktp: /192, 166.0.151 /MVR_Counter php?SYSTEM=P vl S | | P~
File édlt Wiews  Favorites  Tools  Help Links
e e I@httu:fﬂlQZ.ISE‘D‘151fNVR,CDunter.phu’SVSTEM=P lil - B - [rPage v ChTeds v

(2 Geovision GV-Web Report - People Counting

Device | Group | Log | Query

8 :0onLine @ : Off Line

> Total List GV-Smart Box-pp

> GV-Smart Box-pp@ In 0

> Counting Signage out 0
Average In 0

0

Average Out

Total In: 0 | Total Out: 0 | Stay: 0
® Update Frequency : 60 seconds
® Last Updated : 02:37:55

# Total In(Out): on behalf of today 0:00 until now In(Out) o 545econds later update

# Average In(Out): on behalf of today 0:00 until now average In(Out) per minute

Total Device Real-time In and Out chart

Figure 5-3
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5. Click the Face Counting tab on the upper right corner of the Web page. The Web page
is switched to the Face Counting page similar to the following example.

(2 Geobision GV-Web Report - Face Counting

Device | Group | Log | Query

@ : OnLine 8 : Off Line
> Total List GV-Smart Box - V1 GV-Smart Box-p

> GV-Smart Box - V1@ Facecounts |39 Facecounts |0
> GV-Smart Box-p@ Male a Male 0
Female 0 Female 0

n/a 39 nfa i

Total Male Count: 0 | Total Female Count: O

« Total Male(Female): on behalf of today 0:00 until now male(female) count : Eggtaﬁiggig;e:nf{::A;v:osgecuﬂds

« 48Seconds later update

Total Device Real-time Male and Female of Time-Sharing chart

Figure 5-4

6. To display the graphs, it is required to download Microsoft Silverlight to your computer.
Click the link on the page to start downloading the program.
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5.2 Device Page

On the Device page, you can access two types of face counts of the current day.

Main page On the main page of the Device page, the face counts of the
current day are updated from the GV-Web Report server every
minute. See 5.2.1 Viewing the Counts Updated Every Minute.

Live View Window On the Live View window, you can view live video from a GV-Smart
Box or GV-System. See 5.2.2 Viewing Live Video.

5.2.1 Viewing Face Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the face counts and graphs of all connected GV-Smart

Boxes and GV-Systems.

® g N
(2 6eovision GV-Web Report - Face Counting
ice | Group | Log | Query
@ :OnlLine @ :OffLine
ot et GV-Smart Box - V1 GV-Smart Box-p
» GV-Smart Box - V18 Face counts |39 Face counts |0
» GV-Smart Box-p® Mals 0 e 0
Female a Female a
n/a 39 n/a 1]
Total Male Count: 0 | Total Female Count: 0
+ Total Male(Female): on behalf of today 0:00 until now male(female) count e oioocnls
s 48Seconds later update
Total Device Real-time Male and Female of Time-Sharing chart
25
20
15

The counts on the main page show:

m Face counts: The number of people entered and counted based on face images during
the day.

Male: The number of males entered during the day.

Female: The number of females entered during the day.

n/a: The number of entered people whose gender failed to be recognized.

Total Male Count: The total number of males entered from multiple GV-Smart Boxes

and GV-Systems during the day.
m Total Female Count: The total number of females entered from multiple GV-Smart
Boxes and GV-Systems during the day.
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On the left menu, you can find these options:

m Total List: Select one GV-Smart Box or GV-System under the list to see its individual
face counts. A green mark indicates that the device is now updating data to the GV-Web
Report server; otherwise a red mark appears. On the individual device’s page, the face
counts of the current day are updated every minute from the GV-Web Report server.

©® Camera: Access the live video if remote access is enabled on both the device and
GV-Web Report server. See 5.2.2 Viewing Live Video.

(2 GeoUision GV-Web Report - Face Counting

e —
SOl GV-Smart Box

> GV-Smart Box@ Face counts 141
» CAMERA_NAME(Live View) Male 30
» GV-Smart Box-PP@ Female 10
» CAMERA_NAME(Live View) n/a 101

Total Male Count: 30 | Total Female Count: 10

» Total Male{Female): on behalf of today 0:00 until now male(female) count

Figure 5-6

5.2.2 Viewing Live Video

To access live video, select the desired camera from the left menu of the Device page. Make
sure remote access to GV-Systems and GV-Smart Boxes has been enabled on GV-Web
Report. See 3.6.3 Remote Access settings for details on how to allow remote access. You
will also need to enable Webcam Server on the GV-System. See Chapter 8, DVR User’s
Manual on the Surveillance System Software DVD.

(2 6eovision GV-Web Report - Face Counting

ice | Group | Log | Query

@ : Online 8 : Off Line
> Total List

> GV-Smart Box@ 13:39:39 Play

> CAMERA_NAME(Live View) -

A e 210/06!1513:39:39

e GEOVISIBN

Figure 5-7

By clicking the [>] icon on the Live View window, you can view the live video from the GV-
Smart Box or GV-System.
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5.3 Group Page

On the Group page, you can group different cameras from different GV-Smart Boxes and
GV-Systems, and then see the face counts of the set group.

To set up a group:
1. Select Add Group from the left menu of the Group page. This page appears.
A

Q - N
GeoUision GV-Web Report - Face Counting
Device | Group | Log | Query
> groupl Group ’—|
Manage Group GV-5mart Box
z.Add Group [JcAMERA_NAME
> Maintain Group Camera GV-Smart Box-PP_
[l camERA_NAME

Figure 5-8
2. Name the group.
3. Select the cameras that you want to include in the group.
4. Click Submit.

5. From Total List in the left menu, select the set Group to see the sum of every face count

from those selected cameras.

On the left menu of the Group page, you can find these options:

B Total List: Access the face counts of the set groups updated every minute from the
GV-Web Report server.

®  Manage Group:
© Add Group: Select this option to set a group.

® Maintain Group: Select this option to modify the group setting or delete a group.

40



5.4 Log Page

B Accessing Face Counting Page

On the Log page, you can view the gender and age recognition results of a specified time

period and the snapshots from GV-Smart Boxes and GV-Systems.

DST: @selectall Oy ON

C eatis :
GeoUision GV-Web Report - Face Counting
Device | Group | Log | Query User: 1 Log|
® The page show record 1-3 , total number of records : 3
I v total number of pages : 1
Device:
OGruup: Q Result List
- . Image
Gender: |All all Device Name Camera Start Time End Time Gender Age Snapshot
Age: |All | GV-Smart Box- 2010-05-28 2010-05-28 N/A
= i CAMERA_NAME & i11- e A 7] |0~50~6 v S}
Start [2010-05-28 [ 00 ;00 v : v1 (M - 14:11:31 05:10:23 NA v
Time: [gg | GV-Smart Box- | 2010-05-28 2010-05-28 N/A —r
d e v1 CAMERA_NAME & 14:11:31 05:11:21 NA v |9O0-8 =
2 S GV-Smart Box- " 2010-05-28 2010-05-28 ale fe I
59 1 Vi CAMERA_NAME | "4 131 05:11:21 Male v 80~65 v -

B E]

To search the log data:

1.

Figure 5-9

Select a specific GV-Smart Box or GV-System from the Device drop-down list or a

created group from the Group drop-down list.

Specify Gender and Age of the log data.

Specify Start Time and End Time of the log data.

You can select whether to search the DST (Daylight Saving Time) data. Select All

indicates searching all data including DST data, Y indicates searching only DST data

and N indicates not searching DST data.

Click Query to display the search results.

B Gender: You can view the gender of the person entered. N/A appears when the

GV-Smart Box or GV-System fails to recognize the gender. You can also manually

specify the gender with the drop-down list if necessary. The modified data will be
updated to the database of the GV-Web Report.

B Age: You can view the age range of the person entered. You can also manually

specify the age group with the drop-down list if necessary. The modified data will be
updated to the database of the GV-Web Report.

B Image Snapshot: You can view the snapshot of the person entered by clicking the

Q

icon.

To back up the found log data in EXCEL and WORD format, click the icons@ ] in the

bottom of the Query Result List.
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5.5 Query Page

The Query page provides you with the daily, weekly, monthly and yearly face counting
graphs and tables. To search the face counting data, select a GV-Smart Box or GV-System
from the Device drop-down list or a created group from the Group drop-down list, specify a

date, and select the following options below. Use the Chart drop-down list [Chart : [Line Graph
above the graphs to choose to display the data using bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data.
e Male Female Count per 60 Minutes
e Total Male and Female count per 60 Minutes
e Age range Count per 60 Minutes

e Total range Count per 60 Minutes.

[Daily Report] Display the face counting report of the specified date.

m Male/Female count per 60 minutes: The hourly number of males and females entered
during the day.

m Total male and female count per 60 minutes: The hourly accumulated number of
males and females entered during the day.

m Male and female percentage: The total number and the percentage of males and
females entered during the day.

m Age range count per 60 minute: The hourly number of people of each age range
entered during the day.

m Total Age range count per 60 minutes: The hourly accumulated number of people of
each age group entered during the day.

m Age range percentage: The total number and the percentage of people of each age
range entered during the day.
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B Accessing Face Counting Page

The following figure is an example of the Male/Female count per 60 minutes option. The
value 9, 5 indicates the count of males until 9 am is 5.

] 2l .
(- GeoUision GV-Web Report - Face Counting
Device | Group | Log | Query Yeer 4 Logout
-~
Ocraup: _ [2010-11-01] Male,female count per 60 minutes(All Device)
Time: =0

Daily Report(2010-11-1)

80
Male,female count per 60 minutes

Total male and female count per 60 o

minutes

mMale and female percentage &

Age range count per 60 minukes s0

Total age range count per 60

minutes a0

Age range Percentage
o 20

20

10

a 1 2 3 4 5 6 7 8 5 10 11 12 13 14 15 16 18
== Male ="= Female =D= N/A
Time Male Female 1Y Sum
0;00 1 13 43 57
1:.00 1 10 5 16
2:00 [&] 10 12 28
200 3 2 a 7
.00 3 7 a 12
5:00 5] Q 3 18
G500 335 36 4 73
7:00 7 9 o 16
Figure 5-10

[Weekly Report] Display the weekly report that contains the data of 7 days before your
specified date.

m  Male count percentage: The daily number and the percentage of males entered for the
week.

m Female count percentage: The daily number and the percentage of females entered for
the week.

m Male and female percentage: The total number and the percentage of males and
females entered for the week.

m Age range percentage: The total number and the percentage of people of each age
range entered for the week.
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The following figure is an example of the Age range percentage option. The value 30 ~ 35,
321 (32.96%) indicates the number of 30 ~ 35 year-olds entered is 321. 30 ~ 35 year-olds
takes up 32.96 percent of all persons entered that week.

»» People Counting

Q GeoUision

GV-Web Report - Face Counting

Device | Group | Log | Query

& Device: Chart : | Pie Graph |+

Al .
O Group [2010-10-26~2010-11-01] Age range Percentage(All Device)

Time: [2010-11-1 |7

User: 1 Logout

>

30 ~ 35, 321(32.96%)

Male count percentage

Female count percentage

Male and female percentage

&=

Age range Percentage
Monthly Report(2010-10-(

®0~5® 15~20 @ 20~25 » 30~35 @ 40~45 @ 50~55  55~60 @ 60~B65 @ 65~70

Age Counter Percentage
O~ 3 128 13.14
15~ 20 70 7.19 a
20 ~ 25 377 38,71
30~ 35 321 32.96
40~ 43 9 9

Figure 5-11
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B Accessing Face Counting Page

[Monthly Report] Display the monthly report that contains the data of a month before your
specified date.

m Male count percentage: The daily number and the percentage of males entered for the

month.

m Female count percentage: The daily number and the percentage of females entered for
the month.

m Male and female percentage: The total number and the percentage of males and
females entered for the month.

B Age range percentage: The total number and the percentage of persons of each age
range entered for the month.

[Yearly Report] Display the yearly report that contains the data of a year before your
specified date.

m Male count percentage: The monthly number and the percentage of males entered for
the year.

m Female count percentage: The monthly number and the percentage of females entered
for the year.

m Male and female percentage: The total number and the percentage of males and
females entered for the year.

m Age range percentage: The total number and the percentage of people of each age
range entered for the year.
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Chapter 6 Mobile Phone Connection

Using iPhone, iPad or other mobile devices with built-in Android OS, you can view people
counting and face counting results on your mobile phone. After logging in, you can query the

data and chart for people counting and face counting results.

1. On your mobile device, type the IP address of the GV-Web Report server in the address

field of the browser. The login dialog box appears.

ain
4 © P + | 192.168.0.198/Geo_Login_mobilephp7L... & |

: )
Password: [ ]

D Remember my Account and Password

Figure 6-1

2. Type the account ID and password.

3. Click Login. The People Counting results for that day appear.

Untitled
L | 01 A 4 | 192168.0.19%App/Counter_Live_mobile.... G |[

Data | Chart

People Counting [ 2010-11-01] Logout

Device : | All \/
GV-Smart Box
In 721
Out 456

Average In |1
Average Out |0

Total In: 721 | Total Out: 456 | Stay: 265

» Total In(Out): on behalf of today 0:00
until now In(Out)

* Average In(Out): on behalf of today
0:00 until now average In(Out) per
minute

Figure 6-2
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To see the data of other devices, tap the Device drop-down list.

To see graphs of the results, tap the Chart tab on the top. This window appears.

Untitled

4 © [ 4 [ 192.168.0.199App/Counter_Live mobie.... G |(
Data | Chart People Counting n
Date : lfl Logout
Device : | Al v
2010-11-01

InfOut Counts per hour and Total Stay
300

250
200
150
100

50 & A

Figure 6-3

Tap the Date drop-down list to select a date and tap the Device drop-down list to select
a device.

Use the Type drop-down list to display the results of that day, week, month or year.

To switch to Face Counting results, tap the People Counting button on the top-right
corner and select Face Counting. The Face Counting results for that day appear.

4 [ [ 4 | 192.168.0.199Mpp/Caunter_Liva_F_mobi_.. &

Data | Chart  (Fece Cauning i)

Face Counting [ 2010-11-01 ] Logout
Device : | All ¥

GV-Smart Box

Face counts |974
Male 391
Female 455
n/a 128

Total Male Count: 391 | Total Female
Count: 455

s Total Male(Female): on behalf of today
0:00 until now male(female) count

Figure 6-4
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9. To see the data of other devices, tap the Device drop-down list.

10. To see graphs of the results, tap the Chart tab on the top. This window appears.

uuuuuu

« 0 O 4  92.182.019%AppCounter_Live_7_mubi... & |(

Data | Chart
pate : [ 2010-11-01 | Logout

Device : [ Al e
2010-11-01

Male, female count per G0 mimutes
100 -

.-'i'\'

80

60

Figure 6-5

11. Tap the Date drop-down list to select a date and tap the Device drop-down list to select
a device.

12. Use the Type drop-down list to display the results of that day, week, month or year.
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Appendix

Appendix

A. Enabling UPnP in Windows XP

1. Go to Windows Start, click Start button, select Settings, and select Network
Connections. This window appears.

™, Network Connections M= ES
File Edit Wiew Favaorites Tools  Advanced Help | 1','
.L.) Back = I - lw /_)Search W~ Folders ‘ = 2 x n | v

Address &) Network Connections =l =8
Name [ Type [ status [ Device Name Phone # or Host Address | Gwner, [

LAN ot High-Speed Internet

L Local Area Connection LAN or High-Speed Tnter...  Connected Realtek RTLEL 30 Family ... System

2. Right-click one Local Area Connection, select Properties, and click the Advanced tab.
This dialog box appears.

-4 Local Area Connection Properties e ]

Generall Authentication  Advanced I

Windows Firewall

Protect my computer and netwaork by limiting
of preventing access to this computer from
the Interet

3. Click the Settings tab, and click Exceptions tab. This dialog box appears.

=
General Ewceptions | Advancedl

windaws Fireweal is turned off. ¥our computer is at risk of attacks and intrusions
from outside sources such as the Intemet. “We recommend that you click the
General tab and select On.

Programs and Services:

Hame

[ File and Printer Shating
Remote Assistance

Add Program. Add Port. Edit. Delete

V¥ Display a notification when ‘Windows Firewall blocks a program

‘wihat are the risks of allowing exceptions?

Cancel

4. Select UPnP Framework, and click OK.
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B. Modifying Port Number for running GV-Web Report on the same

computer with GV-System

Since the GV-Web Report server and the WebCam Server of GV-System use the same
HTTP port number of 80 to connect to the Web, it is required to modify the port number of
either GV-Web Report or WebCam Server if the two are run on the same computer. If not,
the following message will appear and you cannot access the Web interface of the GV-Web
Report server:

Starting Web Server Failed

To modify the HTTP port number of GV-Web Report:
1. Click Tools from the menu bar and select General Setting.

2. Inthe Web Server section, change the default Listen Port of 80 to a different port number
within the range of 1024 to 65535.

3. Click Apply.
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